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Safety Notices

CAUTION

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or 
adhered to, could result in damage 
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WARNING
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result in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the indicated 
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http://www.keysight.com/find/sweula
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Power Measurement Application—At a Glance
The HD300PWRA Power Measurement Application for the InfiniiVision HD3-Series 
oscilloscopes lets you quickly and easily analyze switching power supply efficiency 
and reliability.

With the Power Measurement Application, you can:

• Measure switching loss and conduction loss at the switching device (to help
improve efficiency).

• Analyze dI/dt and dV/dt slew rate (for reliable operation).

• Automate oscilloscope setup for ripple measurements (to eliminate tedious
manual oscilloscope set up).

• Perform pre-compliance testing to IEC 61000-3-2 standards (to reduce
compliance testing time).

• Analyze line power with total harmonic distortion, true power, apparent power,
power factor, and crest factor tests (to quickly provide power quality
information).

• Measure output noise (ripple).

• Analyze modulation using the on-time and off-time information of a Pulse
Width Modulation (PWM) signal (to help characterize the active power factor).

Figure 1 Switch-Mode Power Supply (SMPS) Block Diagram and Types of Measurements
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• Measure how well a circuit rejects ripple coming from the input power supply at
various frequencies with the Power Supply Rejection Ratio (PSRR)
measurement.

The power measurement and analysis license, along with the oscilloscope, 
high-voltage differential probe, current probe, probe deskew fixture, and passive 
probe, form a complete power measurement system for power supply design and 
testing.

This guide describes:

• Chapter 1, “Prerequisites,” starting on page 7

• Chapter 2, “Getting Started,” starting on page 11

• Chapter 3, “Performing Power Analysis,” starting on page 19

• Chapter 4, “Automatic Power Measurements,” starting on page 65



Power Measurement Application User's Guide 5

Contents
Power Measurement Application—At a Glance / 3

1 Prerequisites

Safety / 7

Oscilloscope Requirements / 7
Bandwidth Requirements / 7
Memory Requirements / 8
Software Version Requirements / 8

Probe Requirements / 9
Voltage Probe / 9
Current Probe / 9
De-Skewing the Voltage and Current Probes / 10

2 Getting Started

Step 1: Access the Power Measurement Application / 11

Step 2: Perform channel deskew / 12

Step 3: Select the type of power analysis / 15

Step 4: Make DUT connections and set up signals / 16

Step 5: Change the analysis settings (if available) / 17

Step 6: Apply the analysis / 18

Step 7: View the analysis results / 18

3 Performing Power Analysis

Input Measurements / 19
Power Quality / 19
Current Harmonics / 23
Inrush Current / 27

Switching Measurements / 29
Rds(on) and Vce(sat) / 29
Switching Loss / 33
Slew Rate / 37
Modulation / 39



6 Power Measurement Application User's Guide

 

Output Measurements / 43
Output Ripple / 43
Turn On/Turn Off / 45
Transient Response / 48
Efficiency / 51

Frequency Response Measurements / 55
Power Supply Rejection Ratio (PSRR) / 55
Control Loop Response (Bode) / 59

4 Automatic Power Measurements

Power Factor / 65

Real Power / 66

Apparent Power / 66

Reactive Power / 66

Crest Factor / 66

Phase Angle / 67

Output Ripple / 67

Input Power / 67

Output Power / 67

Efficiency / 68

Peak Current / 68

Transient / 68

Turn On Time / 68

Turn Off Time / 69

Rds(on) / 69

Vce(sat) / 69

Power Loss / 69

Power Loss/Cyc / 69

Energy Loss / 70

Index



7

Power Measurement Application 
User's Guide

1 Prerequisites

Safety / 7
Oscilloscope Requirements / 7
Probe Requirements / 9

This chapter describes safety considerations and the necessary requirements for 
using the Power Measurement Application.

Safety

Oscilloscope Requirements

The HD300PWRA Power Measurement Application works with the InfiniiVision 
DH3-Series digital storage oscilloscopes (DSO).

Characteristics of the power supply under test determine the oscilloscope 
bandwidth and memory required.

• "Bandwidth Requirements" on page 7

• "Memory Requirements" on page 8

• "Software Version Requirements" on page 8

Bandwidth Requirements

The bandwidth requirements of the oscilloscope and probe are driven by the slew 
rate (rise/fall times) of the switching device.

WARNING When connecting to a circuit with hazardous voltages, make sure the probes and 
other components are used within their ratings. Refer to the probes' and other 
components' documentation.
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For oscilloscopes with Gaussian response (typical for 1 GHz and lower bandwidth 
oscilloscopes), the oscilloscope's rise time is commonly related to the 
oscilloscope's bandwidth using the formula:

rise time = 0.35/bandwidth

To measure an input signal's rise time with ±5% error, the oscilloscope's rise time 
must be 1/3 of the input signal's rise time. Therefore, the oscilloscope bandwidth 
required is:

BW = [ 0.35 / (input signal rise time / 3) ]

For example, a switching device whose rise time is 10 ns requires oscilloscope (and 
probe) bandwidth of 105 MHz.

Memory Requirements

The memory requirements of the oscilloscope depend on the time range and the 
types of signals to capture:

memory depth = time range * sample rate

• For switching device signals: If you need to capture the switching signals for the 
duration of half the mains cycle (60 Hz), with a slew rate of 50 ns (using a 
sampling rate that is four times the required bandwidth), memory depth = 
8.333 ms * 21 MHz * 4 = 699972 points.

With InfiniiVision HD3-Series oscilloscopes, by default, the sampling rate is 
determined by time range setting. In the above case, the sample rate for the 
time range of 8.333 ms is 10 MSa/s; therefore, the memory depth needed is 
8333000 points.

• For input AC line signals: You need to capture a few cycles in order to plot the 
FFT. Resolution of the FFT plot = sampling rate / data size. The expected 
harmonics are in multiples of 50/60 Hz.

Because the input signals have low frequency components, a high sampling 
rate is unnecessary. For example, the RTCA-DO-160E specification states that 
a sampling rate of 100 kSa/s and higher should be sufficient. For a 60 Hz 
signal, to capture 10 cycles you need to capture a duration of 83.33 ms.

The InfiniiVision HD3-Series oscilloscopes set the sampling rate to be 
800 MSa/s for the above time range. The memory depth required is 66.7 
Mpoints with an FFT resolution of 18.0 Hz.

Software Version Requirements

Table 1 Oscilloscope Software Version Required

Oscilloscope Family Software Version Required

InfiniiVision HD3-Series 10.15 or later
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Probe Requirements

• "Voltage Probe" on page 9

• "Current Probe" on page 9

• "De-Skewing the Voltage and Current Probes" on page 10

Voltage Probe

You can use the following voltage probes:

• Keysight N2791A differential probe, 25 MHz, 700 V dynamic range.

• Keysight N2790A differential probe with AutoProbe interface, 100 MHz, 1.4 kV 
dynamic range.

• Keysight N2792A differential probe, 200 MHz bandwidth, 20 V dynamic range.

• Keysight N2793A differential probe, 800 MHz bandwidth, 15 V dynamic range.

• Keysight N2891A high-voltage differential probe, 70 MHz bandwidth, 7 kV 
dynamic range.

• Keysight 1141A differential probe, 200 MHz bandwidth, 400 V dynamic range.

• Keysight 10070D passive probe 1:1, 20 MHz bandwidth, 400 V max. input (for 
power supply noise measurement and for Power Supply Rejection Ratio 
measurement).

• Keysight N2870A passive probe, 1:1, 35 MHz bandwidth, 55 V max input (for 
power supply noise measurement and for Power Supply Rejection Ratio 
measurement).

For voltage probe bandwidth requirements, see "Bandwidth Requirements" on 
page 7.

The probe's voltage range required depends on the input signals to measure. An 
AC-DC switch mode power supply needs a high voltage range probe because the 
switching signals and input line signals can go up to 700 Vpp. For a DC-DC switch 
mode power supply, a smaller probe voltage range is sufficient because the signal 
amplitudes are much smaller.

A passive probe is typically used to measure DC output and transient response.

Current Probe

You can use the following Keysight AC/DC current probes:

• 1147B 50 MHz bandwidth, 15A peak.

• N2893A 100 MHz bandwidth, 30A peak.

• N2780A 2 MHz bandwidth, 500A peak.

• N2781A 10 MHz bandwidth, 150A peak.
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• N2782A 50 MHz bandwidth, 30A peak.

• N2783A 100 MHz bandwidth, 30A peak.

For current probe bandwidth requirements, see "Bandwidth Requirements" on 
page 7.

De-Skewing the Voltage and Current Probes

To ensure accurate power loss measurements, use the U1880A deskew fixture to 
adjust the skew for any time delay differences between the current probe and 
voltage probe signal paths.

The procedure on de-skewing probes is described in Chapter 2, “Getting Started,” 
starting on page 11.

Table 2 U1880A Deskew Fixture Environmental Characteristics

Temperature Operating: –10 °C to +55 °C

Non-operating: –20 °C to +60 °C

Humidity Operating: 95% RH at 40 °C for 24 hr

Non-operating: 90% RH at 65 °C for 24 hr

Altitude Operating: to 4,570 m (15,000 ft)

Non-operating: to 15,244 m (50,000 ft)

Indoor use Rated for indoor use only
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2 Getting Started

Step 1: Access the Power Measurement Application / 11
Step 2: Perform channel deskew / 12
Step 3: Select the type of power analysis / 15
Step 4: Make DUT connections and set up signals / 16
Step 5: Change the analysis settings (if available) / 17
Step 6: Apply the analysis / 18
Step 7: View the analysis results / 18

This chapter gives an overview of the steps you must take when first performing 
power measurements.

Step 1: Access the Power Measurement Application

To access the power measurements application on the oscilloscope:

1 Mrom the main menu, choose Analyze > Power....

2 In the Power dialog box, select On.
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Next • "Step 2: Perform channel deskew" on page 12

Step 2: Perform channel deskew

To make accurate power loss measurements, you must perform current and 
voltage channel deskew using the U1880A deskew fixture. The channel deskew 
procedure calibrates the time delay between current and voltage probes.

You need to perform the deskew procedure once initially, and you should re-run 
the procedure when any part of the hardware setup changes (for example, a 
different probe, different oscilloscope channel, etc.) or when the ambient 
temperature changes.

To perform the channel deskew:

1 First, demagnetize and zero-adjust the current probe. Refer to the current 
probe's documentation for instructions on how to do this.

2 Make connections to the U1880A deskew fixture:
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a Connect D+ and D- of the high-voltage differential probe to the deskew 
fixture.

b Connect the current probe to the current loop with the direction of the arrow 
pointing towards the current flow.

c Make sure the switch on the deskew fixture is set to the appropriate side of 
the fixture (either "small loop" or "large loop").

d Connect the deskew fixture to a USB port on your oscilloscope or a PC using 
a USB cable. The USB port supplies power to the deskew fixture.

3 In the Power dialog box, select the Power Quality test.

Small Loop Large Loop

For current probes: • 1147B (50 MHz, 15A)

• N2893A (10 MHz, 15A)

• N2782A (50 MHz, 30A)

• N2783A (100 MHz, 30A)

• N2780A (2 MHz, 500A)

• N2781A (10 MHz, 150A)

Connect high-voltage 
differential probe to either:

• J5 (2.54 mm connector)

• J6 and J7 (alligator type)

• J2 (2.54 mm connector)

• J3 and J4 (alligator type)
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4 Select Auto Deskew....

5 In the Auto Deskew dialog box, use the Voltage and Current controls to make 
sure the proper analog channels are selected.

6 Select Auto Deskew.

NOTE Use the lowest attenuation setting on the high voltage differential probes whenever possible 
because the voltage levels on the deskew fixture are very small. Using a higher attenuation 
setting may yield inaccurate skew values (and affect the measurements made) because the 
noise level is magnified as well.
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When the deskew process completes, you see a message indicating whether 
the deskew was successful, and if so, the settings being used.

You can also see the skew that was set in the Probe dialog box for the channel 
whose edge is not the trigger.

The deskew values are saved in the oscilloscope until a factory default or secure 
erase is performed. The next time you run the Power application, you can use the 
saved deskew values or perform the deskew again.

Generally, you need to perform the deskew again when part of the test setup 
changes (for example, a different probe, different oscilloscope channel, etc.) or 
when the ambient temperature has changed.

See Also • U1880A Deskew Fixture User's Guide.

Next • "Step 3: Select the type of power analysis" on page 15

Step 3: Select the type of power analysis

1 In the Power dialog box, use the Category list to select the category of 
measurements to choose from. Use the Type list to select the type of power 
analysis.

The following types of power analysis are available:

• Power Quality

• Current Harmonics
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• Inrush Current

• Rds(on) & Vce(sat)

• Switching Loss

• Slew Rate

• Modulation

• Output Ripple

• Turn On/Turn Off

• Transient Response

• Efficiency

• Power Supply Rejection Ratio (PSRR)

• Control Loop Response (Bode)

Next • "Step 4: Make DUT connections and set up signals" on page 16

Step 4: Make DUT connections and set up signals

For each type of power analysis, there is a Signals... button and menu for specifying 
the oscilloscope channels being used and setting other related options.

1 In the Power dialog box, select the Signals....

2 In the Signals dialog box, connect your probes to the device under test and to 
the oscilloscope as shown in the connection diagram.

3 In the above example, you would use the Voltage and Current controls and make 
sure the proper analog channel is selected.
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4 If other controls are present for setting related options, like the Cycles field in 
the above example, use them to specify the appropriate settings.

5 If it is present, select the Auto Setup button to automatically scale and position 
the voltage and current channels and perhaps set the time/div.

6 Close the Signals dialog box.

Next • "Step 5: Change the analysis settings (if available)" on page 17

Step 5: Change the analysis settings (if available)

If there are settings available for the type of power analysis chosen, there will be a 
Settings... or other controls in the Power dialog box.

To specify the power analysis settings:

1 In the Power dialog box, select Settings... or other controls to make the 
appropriate settings for the type of analysis being performed.

For example, the Settings dialog box for the Current Harmonics test looks like:

For descriptions of the settings available for each type of power analysis, see 
Chapter 3, “Performing Power Analysis,” starting on page 19.

2 When you have finished changing the settings, close the Settings dialog box to 
return to the Power dialog box.

Next • "Step 6: Apply the analysis" on page 18

NOTE Be sure to select the proper attenuation factor used for the voltage probe.

The attenuation factor multiplied by the probe's maximum output voltage gives the maximum 
input signal. For example, the N2791A probe's maximum output voltage is ±7V, so a 100:1 
attenuation ratio gives a maximum input signal of ±700V.

NOTE Also, be sure to select the proper attenuation factor used for the current probe.
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Step 6: Apply the analysis

Each type of power analysis provides an Apply button for starting the analysis.

1 In the Power dialog box, select Apply.

Next • "Step 7: View the analysis results" on page 18

Step 7: View the analysis results

Once a power analysis has completed, you can view the results in the following 
ways:

• By viewing the power analysis results on screen.

• By adding automatic power measurements.

Viewing Power
Analysis Results

on Screen

Power analysis results are displayed on the oscilloscope screen.

For example, here is a Current Harmonics analysis result:

Adding Automatic
Power

Measurements

Just like adding automatic measurements of voltage (peak-to-peak, max, min, 
etc.) and time (frequency, period, rise time, fall time, etc.), you can also add 
automatic power measurements. See Chapter 4, “Automatic Power 
Measurements,” starting on page 65.

See Also To learn more about the individual types of power analysis, their input signals, 
their settings, and their results, see:

• Chapter 3, “Performing Power Analysis,” starting on page 19
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Input Measurements / 19
Switching Measurements / 29
Output Measurements / 43
Frequency Response Measurements / 55

This chapter describes the types of power analysis you can perform with the Power 
Measurement Application, the proper probing connections to the device under 
test, signal setup, settings, and results.

Input Measurements

• "Power Quality" on page 19

• "Current Harmonics" on page 23

• "Inrush Current" on page 27

Power Quality

The Power Quality analysis shows the quality of the AC input line.

Some AC current may flow back into and back out of the load without delivering 
energy. This current, called reactive or harmonic current, gives rise to an 
"apparent" power which is larger than the actual power consumed. Power quality 
is gauged by these measurements: power factor, apparent power, true power, 
reactive power, crest factor, and phase angle of the current and voltage of the AC 
line.

Signals Setup 1 With the Power Quality analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.
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a Connect D+ of the voltage probe to the live wire of the AC input.

b Connect D- of the voltage probe to the neutral wire of the AC input.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the live wire of the AC input with the direction 
of the arrow pointing towards the current flow.

e Connect the voltage and current probes to the oscilloscope input channels.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Use the Cycles field to enter the desired number of cycles to capture in one 
acquisition.

6 Select Auto Setup to automatically set the vertical scale and position of the 
voltage and current channels.

Figure 2 Typical Configuration for Input Line Analysis Tests
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Also displayed is the power waveform which is the math multiply operator of 
the voltage and current waveforms.

7 Close the Signals dialog box to return to the Power dialog box.

Statistics The Statistics... button appears in the Power dialog box whenever the selected type 
of analysis adds automatic measurements to the Results pane.

The Statistics... button is a shortcut that opens the Measurements dialog box, with 
the Settings tab selected, where you can disable or reenable measurement 
statistics and select other statistics-related options.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

When the analysis has completed, results are displayed.
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The voltage and current waveforms are displayed as well as the input power 
waveform (waveform math multiply of the voltage and current). Also displayed are 
the power quality measurements you have selected and applied:

• Power Factor — Ratio of the actual power to the apparent power. See "Power 
Factor" on page 65.

• Real (Actual) Power — The portion of power flow that, averaged over a complete 
cycle of the AC waveform, results in net transfer of energy in one direction. See 
"Real Power" on page 66.

• Apparent Power — The portion of power flow due to stored energy, which returns 
to the source in each cycle. See "Apparent Power" on page 66.

• Reactive Power — The difference between apparent power and real power due to 
reactance. See "Reactive Power" on page 66.

• Crest Factor — Crest factor is the ratio between the instantaneous peak 
current/voltage required by the load and the RMS current/voltage (RMS stands 
for Root Mean Square, which is a type of average). See "Crest Factor" on 
page 66.

• Phase Angle — In the power triangle (the right triangle where apparent_power2 = 
real_power2 + reactive_power2), phase angle is the angle between the apparent 
power and the real power, indicating the amount of reactive power. See "Phase 
Angle" on page 67.

• DC RMS over one cycle. Refer to oscilloscope User's Guide for more 
information.

• Frequency. Refer to oscilloscope User's Guide for more information.
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Power quality measurements are calculated using the captured voltage and 
current waveforms over the number of cycles specified.

Current Harmonics

Switching power supplies draw a range of harmonics from the AC mains.

Standard limits are set for these harmonics because these harmonics can travel 
back to the supply grid and cause problems with other devices on the grid.

Use the Current Harmonics analysis to test a switching power supply's current 
harmonics to pre-compliance standard of IEC61000-3-2 (Class A, B, C, or D). The 
analysis presents up to 40 harmonics.

Signals Setup 1 With the Current Harmonics analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect D+ of the voltage probe to the live wire of the AC input.

b Connect D- of the voltage probe to the neutral wire of the AC input.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the live wire of the AC input with the direction 
of the arrow pointing towards the current flow.

e Connect the voltage and current probes to the desired oscilloscope 
channels.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

Figure 3 Typical Configuration for Input Line Analysis Tests
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4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Use the Cycles field to enter the desired number of cycles to capture in one 
acquisition.

6 Select Auto Setup to automatically scale and position the voltage and current 
channels and set the appropriate time/div.

Also set automatically is the Hanning FFT window (for better frequency 
resolution and low spectral leakage). If you choose to set up signals manually, 
you can select other FFT windows for analysis, such as the Blackman-Harris 
window (for minimal spectral leakage) or the Hamming window (for better 
frequency resolution and moderate spectral leakage).

7 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, select Settings....

2 In the Settings dialog box, make the appropriate settings.
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After the analysis has been performed, you can return to the settings menu to:

• Change the display type.

• When the Class D standard is selected and results are displayed in Bar Chart 
form, use the Display control to choose whether results are displayed as RMS 
or current-per-watt (mA/W) values. (The table display option includes both 
RMS and mA/W values.)

3 When you have finished changing the settings, close the Settings dialog box to 
return to the Power dialog box.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

When the analysis has completed, results are displayed.

Table 3 Current Harmonics Analysis Settings

Setting Description

Line Freq Enter the line frequency.

Standard Select the standard to perform compliance testing on the current 
harmonics.

• IEC 61000-3-2 Class A — for balanced three-phase equipment, 
household appliances (except equipment identified as Class D), tools 
excluding portable tools, dimmers for incandescent lamps, and audio 
equipment.

• IEC 61000-3-2 Class B — for portable tools.

• IEC 61000-3-2 Class C — for lighting equipment. Class C requires a 
power factor calculation that happens when the Apply (in the Power 
dialog box) is selected. For this reason, you are only allowed to select 
Class C when the Power application is disabled — it forces you to select 
Apply (again) to perform the analysis.

• IEC 61000-3-2 Class D — for equipment having a specified power 
according less than or equal to 600 W, of the following types: personal 
computers and personal computer monitors, television receivers.

Class D Settings When the Class D standard is selected, use the these controls to specify 
whether the Real Power value used for the current-per-watt measurement 
is measured by the oscilloscope or is user-defined. When user-defined is 
selected, enter the value.

Display Choose how to display harmonics:

• Table.

• Bar Chart.

• Off — Harmonics measurement results are not displayed.
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Table 4 Current Harmonics Test Results

FFT waveform Shows the frequency components in the input current. The FFT is 
calculated using the Hanning window.

Harmonic, Actual Value (RMS), 
Limit (RMS), Margin, Pass/Fail 
Status

For the first 40 harmonics, these values are displayed:

• Actual Value (RMS) — the measured value in the units specified 
by the Harmonics Unit parameter.

• Limit (RMS) — the limit specified by the selected Current 
Harmonics Standard parameter.

• Margin — the margin specified by the selected Current 
Harmonics Standard parameter.

• Pass/Fail Status — whether the value passes or fails according 
to the selected Current Harmonics Standard.

Rows in the table or bars in the chart are color-coded 
according to pass/fail values.

Marginal results are greater than 85% of the limit but less than 
100% of the limit.

THD (Total Harmonic 
Distortion)

Where:

• Xn = voltage or current of each harmonic

• X1 = fundamental voltage or current value
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Saving Harmonics
Test Results

To save current harmonics test results to a USB storage device:

1 From the main menu, choose File > Save....

2 In the Save dialog box, from the Format drop-down menu, select Current 
Harmonics data (*.csv).

3 Select the File Name field, and enter the name of the file you want to save.

4 Use the controls in the bottom of the dialog box to navigate to the location of 
the file to be saved.

5 Select Save.

A message indicating whether the save was successful is displayed.

Automatic
Measurements

You can add these relevant automatic measurements using the [Measure] key and 
dialog box.

Automatic Power App measurements:

• "Apparent Power" on page 66

• "Crest Factor" on page 66

Automatic Voltage measurements (refer to oscilloscope User's Guide for more 
information):

• AC - RMS

Inrush Current

The Inrush current analysis measures the peak inrush current of the power supply 
when the power supply is first turned on.

Signals Setup 1 With the Inrush analysis selected in the Power dialog box, select Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.
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a Connect D+ of the voltage probe to the live wire of the AC input.

b Connect D- of the voltage probe to the neutral wire of the AC input.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the live wire of the AC input with the direction 
of the arrow pointing towards the current flow.

e Connect the voltage and current probes to the oscilloscope input channels.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 For the Input Type control, select the type of power that is being converted from 
the input to the output. Your selection affects how the measurements are made.

6 In the Max Vin field, enter the maximum input voltage. This sets the vertical 
scale of the channel probing voltage.

Figure 4 Typical Configuration for Inrush Current Analysis Tests
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7 In the Expected field, enter the expected inrush current amplitude. This sets the 
vertical scale of the channel probing current.

8 Close the Signals dialog box to return to the Power dialog box.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

Follow the onscreen instructions. When the analysis has completed, results are 
displayed.

The voltage and current waveforms are displayed. Also displayed is this automatic 
power measurement:

• "Peak Current" on page 68

Switching Measurements

•  "Rds(on) and Vce(sat)" on page 29 

•  "Switching Loss" on page 33 

•  "Slew Rate" on page 37 

•  "Modulation" on page 39 

Rds(on) and Vce(sat)

The Rds(on) and Vce(sat) analysis measures these characteristics of a switching 
device. It indicates whether a switching device is operating near the values 
published in the device's data sheet.
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Signals Setup 1 With the Rds(on) & Vce(sat) analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect D+ of the voltage probe to the source of the MOSFET.

b Connect D- of the voltage probe to the drain of the MOSFET.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the drain of the MOSFET with the direction of 
the arrow pointing towards the current flow.

e Connect the voltage and current probes to the oscilloscope input channels.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Select Auto Setup to automatically set the vertical scale and position of the 
voltage and current channels.

Figure 5 Typical Configuration for Power Device Analysis Tests
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6 Close the Signals dialog box to return to the Power dialog box.

Offset Calibration

1 If offset calibration is required, select the Offset Calibration... to be guided 
through a calibration procedure that measures the offset error of the voltage 
input channel and current input channel to correct for oscilloscope/probe offset 
error.

Although the oscilloscope's user calibration (Utilities > Service..., then select the 
Calibration tab) calibrates offsets for all input channels to within ±0.1 division 
for all vertical scale settings, this relatively small amount of offset error can 
contribute significant switching loss measurement error, especially during the 
conduction phase, when voltage is near zero, and also during the 
non-conduction phase, when current is near zero. This is a classic oscilloscope 
dynamic range limitation when attempting to measure small voltages and/or 
currents in the presence of relatively large switching voltages and/or currents.

After performing the Offset Calibration... procedure, precision calibration factors 
are applied when you select Apply to start the power analysis.

If you make any vertical scaling changes to the voltage and/or current 
waveforms, the calibration factors become invalid and a red message appears 
in the menu area indicating that a new Offset Calibration... is required. Select 
Offset Calibration... to create new precision offset calibration factors for the 
current vertical scale settings.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

When the analysis has completed, results are displayed.
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The voltage and current waveforms are displayed, as well as these automatic 
power measurements and statistics:

• "Rds(on)" on page 69

• "Vce(sat)" on page 69

Using Rds(on) and
Vce(sat) Results in

Switching Loss
Analysis

You can use the results of the Rds(on) and Vce(sat) analysis in the Switching Loss 
power analysis:
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• Select Use Rds(on) to start the Switching Loss analysis with its Rds(on) 
conduction calculation setting and the measured mean Rds(on) value.

• Select Use Vce(sat) to start the Switching Loss analysis with its Vce(sat) 
conduction calculation setting and the measured mean Vce(sat) value.

To get a more accurate Rds(on) and Vce(sat) measurements, use the acquisition 
Averaging mode when accumulating the measurement statistics.

Switching Loss

The Switching Loss analysis calculates the power dissipated in the switching 
cycles across the switching device. Typical power losses include:

• Switching losses that occur during switching of Vds and Id.

• Conduction losses that occur when the switching device (MOSFET) is ON.

Design engineers use this information to improve the power conversion efficiency 
of the power supply.

Switching loss is also used to quantify the power loss that is transferred to the heat 
sink of the power device.

Signals Setup 1 With the Switching Loss analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

Figure 6 Loss Occurrence in the Power Device
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a Connect D+ of the voltage probe to the source of the MOSFET.

b Connect D- of the voltage probe to the drain of the MOSFET.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the drain of the MOSFET with the direction of 
the arrow pointing towards the current flow.

e Connect the voltage and current probes to the oscilloscope input channels.

3 Use the Voltage and Current controls to make sure the proper analog channel is 
selected.

4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Select Auto Setup to automatically set the vertical scale and position of the 
voltage and current channels.

6 Close the Signals dialog box to return to the Power Application dialog box.

Settings 1 In the Power Application dialog box, select Settings....

2 In the Settings dialog box, make the appropriate settings.

Figure 7 Typical Configuration for Power Device Analysis Tests
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3 When you have finished changing the settings, close the Settings dialog box to 
return to the Power Application dialog box.

Offset Calibration 1 If offset calibration is required, select the Offset Calibration... to be guided 
through a calibration procedure that measures the offset error of the voltage 

Table 5 Switching Loss Analysis Settings

Setting Description

V Ref Enter the switching level for the switching edges. The value is in 
percentage of the maximum switch voltage.

You can adjust this value to ignore noise floors.

This value specifies the threshold that is used to determine the switching 
edges.

I Ref Enter the switching level for the start of switching edges. The value is in 
percentage of the maximum switch current.

You can adjust this value to ignore noise floors or null offset that is difficult 
to eliminate in current probes.

This value specifies the threshold that is used to determine the switching 
edges.

Conduction Choose how to calculate conduction:

• Voltage Waveform — The Power waveform uses the original data, and 
the calculation is: P = V x I

• Rds(on) — The Power waveform includes error correction:

• In the On Zone (where the voltage level is below V Ref) – the Power 
calculation is: P = Id2 x Rds(on)

Specify Rds(on) using the additional field.

• In the Off Zone (where the current level is below I Ref) – the Power 
calculation is: P = 0 Watt.

• Vce(sat) — The Power waveform includes error correction:

• In the On Zone (where the voltage level is below V Ref) – the Power 
calculation is: P = Vce(sat) x Ic

Specify Vce(sat) using the additional field.

• In the Off Zone (where the current level is below I Ref) – the Power 
calculation is: P = 0 Watt.
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input channel and current input channel to correct for oscilloscope/probe offset 
error.

Although the oscilloscope's user calibration (Utilities > Service..., then select the 
Calibration tab) calibrates offsets for all input channels to within ±0.1 division 
for all vertical scale settings, this relatively small amount of offset error can 
contribute significant switching loss measurement error, especially during the 
conduction phase, when voltage is near zero, and also during the 
non-conduction phase, when current is near zero. This is a classic oscilloscope 
dynamic range limitation when attempting to measure small voltages and/or 
currents in the presence of relatively large switching voltages and/or currents.

After performing the Offset Calibration... procedure, precision calibration factors 
are applied when you select Apply to start the power analysis.

If you make any vertical scaling changes to the voltage and/or current 
waveforms, the calibration factors become invalid and a red message appears 
in the menu area indicating that a new Offset Calibration... is required. Select 
Offset Calibration... to create new precision offset calibration factors for the 
current vertical scale settings.

Analysis Results To perform the analysis, select Apply in the Power Application dialog box.

When the analysis has completed, results are displayed.

The voltage and current waveforms are displayed, as well as the power waveform 
(waveform math multiply of the voltage and current). Also displayed are these 
automatic power measurements and statistics:

• "Power Loss" on page 69
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• "Power Loss/Cyc" on page 69

• "Energy Loss" on page 70

Automatic
Measurements

You can add these relevant automatic measurements using the [Meas] key and 
menu.

Automatic Time measurements (refer to oscilloscope User's Guide for more 
information):

• Frequency

Slew Rate

The Slew Rate analysis measures the rate of voltage or current change during 
switching.

Signals Setup 1 With the Slew Rate analysis selected in the Power dialog box, select Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect D+ of the voltage probe to the source of the MOSFET.

b Connect D- of the voltage probe to the drain of the MOSFET.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the drain of the MOSFET with the direction of 
the arrow pointing towards the current flow.

e Connect the voltage and current probes to the oscilloscope input channels.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

Figure 8 Typical Configuration for Power Device Analysis Tests
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4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Select Auto Setup to automatically set the vertical scale and position of the 
voltage and current channels.

6 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, use the Source control to select either Voltage or Current 
as the source for the slew rate analysis.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

When the analysis has completed, results are displayed.
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The voltage and current waveforms are displayed along with a differentiate math 
function waveform that shows the slew rate.

Max and Min measurements on the differentiate math function waveform are 
added and displayed.

Modulation

The Modulation analysis measures the control pulse signal to a switching device 
(MOSFET) and observes the trending of the pulse width, duty cycle, period, 
frequency, etc. of the control pulse signal in response to different events.

Signals Setup 1 With the Modulation analysis selected in the Power dialog box, select Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

Table 6 Slew Rate Test Results

dV/dt [ y(n) - y(n-1) ] / [ x(n) - x(n-1) ], measures the slew rate of Vds of the 
power device (MOSFET).

dI/dt [ y(n) - y(n-1) ] / [ x(n) - x(n-1) ], measures the slew rate of Id of the 
power device (MOSFET).
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a Connect D+ of the voltage probe to the gate of the MOSFET.

b Connect D- of the voltage probe to the source of the MOSFET.

c On the voltage probe, select the appropriate attenuation ratio.

d Connect the current probe to the drain of the MOSFET.

e Connect the voltage and current probes to oscilloscope input channels.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Use the Duration field to enter the time to capture signals. This sets the time 
scale of the oscilloscope.

6 Select Auto Setup to automatically set the vertical scale and position of the 
voltage and current channels.

Figure 9 Continuous Mode Connection for Modulation Analysis Tests
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7 Adjust the trigger level to capture waveforms at the same place in each cycle 
(in other words, stabilize the waveform display).

8 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, use the Source control to select either Voltage or 
Current as the source for the modulation analysis.

2 Use the Type control to select the type of measurement to make in the 
modulation analysis:

• Average

• RMS - AC

• Ratio

• Period

• Frequency

• +Width

• -Width

• +Duty Cycle

• -Duty Cycle

• Rise Time

• Fall Time

Analysis Results To perform the analysis, press Apply in the Power dialog box.

When the analysis has completed, results are displayed.
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The Measurement Trend math waveform visualization is used to plot the 
measurement variation for each cycle of the modulation waveforms.

Automatic
Measurements

You can add these relevant automatic measurements using the [Meas] key and 
menu.

Automatic Voltage measurements (refer to oscilloscope User's Guide for more 
information):

• Average

• AC - RMS

• Ratio

Automatic Time measurements (refer to oscilloscope User's Guide for more 
information):

• Period

• Frequency

• +Width

• -Width

• +Duty Cycle

• -Duty Cycle

• Rise Time

• Fall Time
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Output Measurements

• "Output Ripple" on page 43

• "Turn On/Turn Off" on page 45

• "Transient Response" on page 48

• "Efficiency" on page 51

Output Ripple

The Output Ripple analysis measures the ripple noise of the power supply output.

Signals Setup 1 With the Output Ripple analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect the voltage probe (passive or differential) to the DC output of the 
power supply.

b Connect the voltage probe to an oscilloscope input channel.

3 Use the Voltage control to make sure the proper analog channel is selected.

Figure 10 Typical Configuration for Output Voltage Ripple Test
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4 Make sure the proper probe attenuation factor is set in the oscilloscope for the 
voltage probe.

5 Use the Duration field to enter the time scale of the measurement.

6 Select Auto Setup to automatically set the vertical scale and position of the 
voltage channel as well as the time scale.

7 Close the Signals dialog box to return to the Power dialog box.

Analysis Results To perform the analysis, press Apply in the Power dialog box.

When the analysis has completed, results are displayed.
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The output voltage waveforms is displayed along with this automatic power 
measurement:

• "Output Ripple" on page 67

Turn On/Turn Off

The Turn On analysis determines how fast a turned on power supply takes to reach 
90% of its steady state output.

The Turn Off analysis determines how fast a turned off power supply takes to 
reduce its output voltage to 10% of maximum.

Signals Setup 1 With the Turn On/Turn Off analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect D+ of the input voltage probe to the live wire of the AC input.

b Connect D- of the input voltage probe to the neutral wire of the AC input.

c On the input voltage probe, select the appropriate attenuation ratio.

d Connect the output voltage probe (passive or differential) to the DC output 
of the power supply.

e Connect the voltage probes to the oscilloscope input channels.

3 Use the Input Voltage and Output Voltage controls to make sure the proper 
analog channels are selected.

Figure 11 Typical Configuration for Turn On/Off Analysis Tests
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4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage probes.

5 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, select Settings....

2 In the Settings dialog box, use the Test control to select whether turn on or turn 
off analysis is performed:

• Turn On — determines how fast a turned on power supply takes to reach 
some percent of its steady state output. Turn on time is the time between T2 
and T1 where:

• T1 = when the input voltage first rises to some percent (typically 10%) of 
its maximum amplitude.

• T2 = when the output DC voltage rises to some percent (typically 90%) of 
its maximum amplitude.

• Turn Off — determines how fast a turned off power supply takes to reduce its 
output voltage to some percent of maximum. Turn off time is the time 
between T2 and T1 where:
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• T1 = when the input voltage last falls to some percent (typically 10%) of 
its maximum amplitude.

• T2 = when the output DC voltage last falls to some percent (typically 
10%) of its maximum amplitude.

The Test control is also in the Power dialog box so you can easily switch 
between the different types of analysis.

3 Use the Input Type control to select the type of power that is being converted 
from the input to the output.

Your selection affects how the efficiency is measured.

4 Use the DC Vin or Max Vin control to enter the maximum input voltage.

Enter the maximum (peak-to-peak) source voltage amplitude. The source 
voltage will be used to trigger the oscilloscope in "Turn On Time" test.

This value is used to adjust the vertical scale of the channel probing the 
oscilloscope input voltage.

5 Use the Steady Vout field to enter the expected steady state output DC voltage 
of the power supply.

This value is used to adjust the vertical scale of the channel probing the 
oscilloscope output voltage.

6 Use the Duration field to enter the time scale of the measurement.

7 Use the Input Threshold field to enter the percent of maximum amplitude that 
identifies T1.

In Turn On analysis, the rising input voltage threshold is typically 10%.

In Turn Off analysis, the falling input voltage threshold is typically 10%.

8 Use the Output Threshold field to enter the percent of maximum amplitude that 
identifies T2.

In Turn On analysis, the rising output voltage threshold is typically 90%.

In Turn Off analysis, the falling output voltage threshold is typically 10%.

9 Close the Settings dialog box to return to the Power dialog box.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

Follow the instructions on screen. When the analysis has completed, results are 
displayed.
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The input and output voltage waveforms are displayed. Also displayed is this 
automatic power measurements:

• "Turn On Time" on page 68

• "Turn Off Time" on page 69

Transient Response

The Transient Response analysis determines how fast a power supply's output 
voltage responds to change at the output load. This time is from when the output 
voltage first exits the settling band to when it last enters the settling band.

Signals Setup 1 With the Transient Response analysis selected in the Power dialog box, select 
Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.
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a Connect the voltage probe (passive or differential) to the DC output of the 
power supply.

b Connect the voltage probe to an oscilloscope input channel.

c Connect the current probe to the output load of the power supply.

The change in the load current will be used to trigger the oscilloscope to 
capture the transients.

d Connect the current probe to an oscilloscope input channel.

3 Use the Voltage and Current controls to make sure the proper analog channels 
are selected.

4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Use the Duration field to enter the time scale of the measurement.

6 Use the Overshoot field to enter the % of overshoot of the output voltage.

Figure 12 Typical Configuration for Power Output Transient Response
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This value will be used to determine the settling band value for the transient 
response and to adjust the vertical scale of the oscilloscope.

7 Use the Steady Vout field to enter the expected steady state output DC voltage 
of the power supply.

This value is used along with the overshoot percentage to specify the settling 
band for the transient response and to adjust the vertical scale of the 
oscilloscope.

8 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, select Settings....

2 In the Settings dialog box, make the appropriate settings.

3 When you have finished changing the settings, close the Settings dialog box to 
return to the Power dialog box.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

Follow the instructions on screen. When the analysis has completed, results are 
displayed.

Table 7 Transient Response Analysis Settings

Setting Description Notes

Low Current Enter the low current value. This is the 
expected low current value before or 
after a load change.

The low current value and the high 
current value are used to calculate the 
trigger level and to adjust the vertical 
scale of the oscilloscope.

As the load changes, and the current 
goes from the low value to the high (or 
vice-versa), the oscilloscope triggers 
and makes the transient response 
settling time measurement.

High Current Enter the high current value. This is 
the expected high current value 
before or after a load change.
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The voltage and current waveforms are displayed. There are start and end time 
stamps that mark the measured area. Also displayed is this automatic power 
measurements:

• "Transient" on page 68

Efficiency

Efficiency analysis tests the overall efficiency of the power supply by measuring 
the output power over the input power. This analysis requires a four-channel 
oscilloscope because input voltage, input current, output voltage, and output 
current are measured.

Signals Setup 1 With the Efficiency analysis selected in the Power dialog box, select Signals....

2 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.
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a Connect D+ of the input voltage probe to the live wire of the AC input.

b Connect D- of the input voltage probe to the neutral of the AC input.

c On the input voltage probe, select the appropriate attenuation ratio.

d Connect the input current probe to the live wire of the AC input with the 
direction of the arrow pointing towards the current flow.

e Connect D+ of the output voltage probe to the input path of the load.

f Connect D- of the output voltage probe to the return path of the load.

g On the output voltage probe, select the appropriate attenuation ratio.

h Connect the output current probe to the input path of the load with the 
direction of the arrow pointing towards the current flow.

i Connect the voltage and current probes to the oscilloscope input channels.

3 Use the Input Voltage, Input Current, Output Voltage, and Output Current controls to 
make sure the proper analog channels are selected.

Figure 13 Typical Configuration for Efficiency Analysis Tests
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4 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage and current probes.

5 Use the Duration field to specify the time to capture signals. This sets the time 
scale of the oscilloscope.

6 Select Auto Setup to automatically set the vertical scale and position of the 
voltage and current channels.

7 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, Use the Type control to select the type of power that is 
being converted from the input to the output.

Your selection affects how the efficiency is measured.

Analysis Results To perform the analysis, select Apply in the Power dialog box.

When the analysis has completed, results are displayed.
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The input voltage, input current, output voltage, and output current waveforms are 
displayed, as well as the input power waveform (waveform math multiply of the 
input voltage and current). Also displayed are these automatic power 
measurements and statistics:

• "Input Power" on page 67

• "Output Power" on page 67

• "Efficiency" on page 68

Automatic
Measurements

You can add these relevant automatic measurements using the [Measure] key and 
dialog box.

Automatic Power App measurements:

• "Real Power" on page 66

• "Apparent Power" on page 66

• "Reactive Power" on page 66

• "Power Factor" on page 65

• "Phase Angle" on page 67

Automatic Voltage measurements (refer to oscilloscope User's Guide for more 
information):

• AC - RMS

• DC - RMS

• Maximum

• Minimum
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• Peak-Peak

Automatic Time measurements (refer to oscilloscope User's Guide for more 
information):

• Frequency

• Phase

Frequency Response Measurements

• "Power Supply Rejection Ratio (PSRR)" on page 55

• "Control Loop Response (Bode)" on page 59

Power Supply Rejection Ratio (PSRR)

The Power Supply Rejection Ratio (PSRR) test is used to determine how well a 
voltage regulator rejects ripple noise over different frequency range.

This analysis provides a signal from the oscilloscope's waveform generator that 
sweeps its frequency. This signal is used to inject ripple to the DC voltage that 
feeds the voltage regulator.

The AC RMS ratio of the input over the output is measured and is plotted over the 
range of frequencies.

There are many different ways to measure PSRR. Because the oscilloscope has a 
higher noise floor and lower sensitivity than a network analyzer, it is difficult to 
measure PSRR any better than -60 dB. The PSRR test using the oscilloscope is 
usually acceptable for spot-checking overall PSRR behavior of a power supply 
under test.
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Signals Setup 1 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect one voltage probe (passive or differential) to the input of the 
low-dropout (LDO) regulator (and ground).

b Connect a second voltage probe (passive or differential) to the output of the 
low-dropout (LDO) regulator (and ground).

c Connect the waveform generator output to the modulated power supply.

One example of a modulated power supply is the TS200 Option 1A from Accel 
Instruments. You can also use an injection transformer to inject the 
oscilloscope's WaveGen signal to a power supply output that is connected to 
the low-dropout (LDO) regulator. In this case, the injection transformer and 
power supply combination replaces a modulated power supply (like TS200).

2 Use the Input Voltage and Output Voltage controls to make sure the proper 
analog channels are selected.

Figure 14 Typical Configuration for Power Supply Rejection Ratio Analysis

http://www.accelinstruments.com/Products/TS200/TS200-Description.html
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3 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage probes.

4 Close the Signals dialog box to return to the Power dialog box.

Settings 1 With the Power Supply Rejection Ratio (PSRR) analysis selected in the Power dialog 
box, select Settings....

2 In the Settings dialog box, make the appropriate settings:
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3 Close the Settings dialog box to return to the Power dialog box.

Analysis Results To perform the analysis, select Apply in the Power dialog box. Measured values are 
plotted on the frequency chart as the analysis is performed.

The plot shows the measured PSRR versus frequency. There are two markers that 
can be positioned on any measurement point.

Setting Description

Frequency Mode You can Sweep though a range of frequencies or perform the analysis at a 
Single frequency.

The Single mode is useful for evaluating amplitudes at a single frequency. 
After running the test at a single frequency, you can manually adjust 
(increase) the waveform generator's amplitude until you begin to observe 
distortion in the waveforms on the oscilloscope's display. You can then 
use that amplitude at all frequencies in Sweep mode, or you can evaluate 
amplitudes at other frequencies in order to determine an optimized 
amplitude profile (using the Amplitude Profile option).

Start Freq, Stop Freq Sets the start and stop sweep frequency values. The measurement is 
displayed on a log scale, so you can select the start frequency from decade 
values, and you can select the stop frequency from decade values in 
addition to the maximum frequency of 100 MHz.

Total # of Points Selects the total number of frequency test points in the sweep.

Input Source, 
Output Source

Make sure the proper analog channels are selected.

WaveGen Amp, 
WaveGen Imp

Sets the waveform generator amplitude value and expected output load 
impedance.

The output impedance of the Gen Out signal is fixed at 50 ohms. However, 
the output load selection lets the waveform generator display the correct 
amplitude and offset levels for the expected output load. If the actual load 
impedance is different than the selected value, the displayed amplitude 
and offset levels will be incorrect.

Amplitude Profile... Select this check box to be able to specify initial waveform generator ramp 
amplitudes for each frequency range.

With amplitude profiling, you can use lower amplitudes at frequencies 
where the device under test (DUT) is sensitive to distortion and use higher 
amplitudes where the DUT is less sensitive to distortion.

You can often observe distortions during the test. If the input test sine 
wave begins to look lopsided, clipped, or somewhat triangular in shape 
(nonsinusoidal), you are probably encountering distortion due to 
overdriving your DUT. Optimizing test amplitudes to achieve the best 
dynamic range measurements is often an iterative process of running your 
frequency response measurements multiple times.
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The Results area table shows: the data point number, the frequency, the waveform 
generator output amplitude, and the measured PSRR. You can scroll the data.

You can right-click a row to Run Single Frequency Test (which is useful for evaluating 
amplitudes at a single frequency).

Saving PSRR Test
Results

To save PSRR test results to a USB storage device:

1 From the main menu, choose File > Save....

2 In the Save dialog box, from the Format drop-down menu, select Power Supply 
Rejection Ratio (PSRR) data (*.csv).

3 Select the File Name field, and enter the name of the file you want to save.

4 Use the controls in the bottom of the dialog box to navigate to the location of 
the file to be saved.

5 Select Save.

A message indicating whether the save was successful is displayed.

Control Loop Response (Bode)

The Control Loop Response (Bode) analysis performs a gain/phase plot over 
frequency sweep. This is used to determine the margin of a control loop.

Phase measurements and plots are only possible if the input and output 
waveforms exceed 1 division peak-to-peak (>1 mVpp).
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Signals Setup 1 Connect your probes to the device under test and to the oscilloscope as shown 
in the connection diagram.

a Connect one voltage probe (passive or differential) to the input of the 
injection resistor (and ground).

b Connect a second voltage probe (passive or differential) to the output of the 
injection resistor (and ground).

c Connect the waveform generator output to the injection transformer that is 
connected in parallel with a low-ohm injection resistor.

The injection resistor should be placed at the low impedance output node 
above the high side feedback resistor in the feedback path.

2 Use the Input Voltage and Output Voltage controls to make sure the proper 
analog channels are selected.

Figure 15 Typical Configuration for Control Loop Response Analysis



Performing Power Analysis 3

Power Measurement Application User's Guide 61

 

3 Make sure the proper probe attenuation factors are set in the oscilloscope for 
the voltage probes.

4 Close the Signals dialog box to return to the Power dialog box.

Settings 1 In the Power dialog box, select Settings....

2 In the Settings dialog box, make the appropriate settings:
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3 Close the Settings dialog box to return to the Power dialog box.

Analysis Results To perform the analysis, press Apply in the Power dialog box. Measured values are 
plotted on the frequency chart as the analysis is performed.

Setting Description

Frequency Mode You can Sweep though a range of frequencies or perform the analysis at a 
Single frequency.

The Single mode is useful for evaluating amplitudes at a single frequency, 
for example, near the expected 0 dB cross-over frequency. After running 
the test at a single frequency, you can manually adjust (increase) the 
waveform generator's amplitude until you begin to observe distortion in 
the waveforms on the oscilloscope's display. You can then use that 
amplitude at all frequencies in Sweep mode, or you can evaluate 
amplitudes at other frequencies in order to determine an optimized 
amplitude profile (using the Amplitude Profile option).

Start Freq, Stop Freq Sets the start and stop sweep frequency values. The measurement is 
displayed on a log scale, so you can select the start frequency from decade 
values, and you can select the stop frequency from decade values in 
addition to the maximum frequency of 100 MHz.

Total # of Points Selects the total number of frequency test points in the sweep.

Input Source, 
Output Source

Make sure the proper analog channels are selected.

WaveGen Amp, 
WaveGen Imp

Sets the waveform generator amplitude value and expected output load 
impedance.

The output impedance of the Gen Out signal is fixed at 50 ohms. However, 
the output load selection lets the waveform generator display the correct 
amplitude and offset levels for the expected output load. If the actual load 
impedance is different than the selected value, the displayed amplitude 
and offset levels will be incorrect.

Amplitude Profile... Select this check box to be able to specify initial waveform generator ramp 
amplitudes for each frequency range.

With amplitude profiling, you can use lower amplitudes at frequencies 
where the device under test (DUT) is sensitive to distortion and use higher 
amplitudes where the DUT is less sensitive to distortion. Power supply 
feedback networks are typically most sensitive near the 0 dB cross-over 
frequency.

You can often observe distortions during the test. If the input test sine 
wave begins to look lopsided, clipped, or somewhat triangular in shape 
(nonsinusoidal), you are probably encountering distortion due to 
overdriving your DUT. Optimizing test amplitudes to achieve the best 
dynamic range measurements is often an iterative process of running your 
frequency response measurements multiple times.
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The plot shows both gain and phase measurements versus frequency. Notice there 
is a phase reference point at 0 dB/0° (which is different than some text book 
descriptions of Bode plots that use a phase reference point of 0 dB/-180°). There 
are two pairs of markers that can be positioned on any measurement point.

The Results area table shows: the data point number, the frequency, the waveform 
generator output amplitude, the measured gain, and the measured phase. You can 
scroll the data.

You can right-click a row to Run Single Frequency Test (which is useful for evaluating 
amplitudes at a single frequency).

Saving Control
Loop Response

Test Results

To save Control Loop Response test results to a USB storage device:

1 From the main menu, choose File > Save....

2 In the Save dialog box, from the Format drop-down menu, select Control Loop 
Response (Bode) data (*.csv).

3 Select the File Name field, and enter the name of the file you want to save.

4 Use the controls in the bottom of the dialog box to navigate to the location of 
the file to be saved.

5 Select Save.

A message indicating whether the save was successful is displayed.
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4 Automatic Power 
Measurements

Power Factor / 65
Real Power / 66
Apparent Power / 66
Reactive Power / 66
Crest Factor / 66
Phase Angle / 67
Output Ripple / 67
Input Power / 67
Output Power / 67
Efficiency / 68
Peak Current / 68
Transient / 68
Turn On Time / 68
Turn Off Time / 69
Rds(on) / 69
Vce(sat) / 69
Power Loss / 69
Power Loss/Cyc / 69
Energy Loss / 70

Power Factor

Ratio of the actual AC line power to the apparent power.

Real Power / Apparent Power

The power factor measurement is made using two source inputs, the voltage 
waveform and the current waveform, and it also requires a math multiply 
waveform of the voltage and current waveforms.
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Real Power

The portion of power flow that, averaged over a complete cycle of the AC 
waveform, results in net transfer of energy in one direction.

The real power measurement is made on one source input that represents power. 
This is typically a math multiply waveform of the voltage and current waveforms.

Apparent Power

The portion of AC line power flow due to stored energy, which returns to the source 
in each cycle.

IRMS * VRMS

The apparent power measurement is made using two source inputs, the voltage 
waveform and the current waveform.

Reactive Power

The difference between apparent power and real power due to reactance. Using 
the power triangle (the right triangle where apparent_power2 = real_power2 + 
reactive_power2):

Measured in VAR (Volts-Amps-Reactive)

The reactive power measurement is made using two source inputs, the voltage 
waveform and the current waveform, and it also requires a math multiply 
waveform of the voltage and current waveforms.

Crest Factor

Crest factor is the ratio between the instantaneous peak AC line current/voltage 
required by the load and the RMS current/voltage.
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Select the voltage source for V crest factor: Vpeak / VRMS

Select the current source for I crest factor: Ipeak / IRMS

Phase Angle

In the power triangle (the right triangle where apparent_power2 = real_power2 + 
reactive_power2), phase angle is the angle between the apparent power and the 
real power, indicating the amount of reactive power. Small phase angles equate to 
less reactive power.

The phase angle measurement is made using two source inputs, the voltage 
waveform and the current waveform, and it also requires a math multiply 
waveform of the voltage and current waveforms.

Output Ripple

VMax - VMin

The output ripple measurement is made on one source input that is the output 
voltage waveform.

Input Power

Input V * Input I

The input power measurement is made using two source inputs, the input voltage 
waveform and the input current waveform, and it also requires a math multiply 
waveform of the voltage and current waveforms.

The input power measurement requires that you specify the channels probing the 
input voltage, input current, output voltage, and output current in the Signals 
dialog box and that you perform the automated signals setup by selecting Auto 
Setup.

Output Power

Output V * Output I

The output power measurement is made using two source inputs, the output 
voltage waveform and the output current waveform, and it also requires a math 
multiply waveform of the voltage and current waveforms.
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The output power measurement requires that you specify the channels probing the 
input voltage, input current, output voltage, and output current in the Signals 
dialog box and that you perform the automated signals setup by selecting Auto 
Setup.

Efficiency

Output power / input power.

The efficiency measurement is made on one source input that represents input 
power. This is typically a math multiply waveform of the input voltage and input 
current waveforms. This measurement also requires the output voltage waveform 
and the output current waveform specified in the signals setup for the Efficiency 
power analysis.

The efficiency measurement requires that you specify the channels probing the 
input voltage, input current, output voltage, and output current in the Signals 
dialog box and that you perform the automated signals setup by selecting Auto 
Setup.

Peak Current

The Peak Current can be a positive or negative value, so the result is the larger of 
the measured maximum or minimum.

The peak current measurement is made on one source input that is the current 
waveform.

Transient

Transient response time = t2 – t1, where:

• t1 = The first time a voltage waveform exits the settling band.

• t2 = The last time it enters into the settling band.

• Settling band = +/- overshoot % of the steady state output voltage.

The transient measurement is made using X cursors on the output voltage signal.

Turn On Time

Turn On time = t2 - t1, where:

• t1 = AC input voltage rises to 10% of its maximum amplitude (Start Time).
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• t2 = DC output voltage rises to 90% of its maximum amplitude (End Time).

The turn on time measurement is made using X cursors on two source inputs, the 
input voltage waveform and the output voltage waveform.

Turn Off Time

Turn Off time = t2 -t1, where:

• t1 = AC input voltage goes below 10% of its positive peak (or negative peak 
which ever occurs first) (Start Time).

• t2 = DC output voltage drops to 10% of its steady state value (End Time).

The turn on time measurement is made using X cursors on two source inputs, the 
input voltage waveform and the output voltage waveform.

Rds(on)

Rds(on) is a switching device characteristic that can be measured by the Rds(on) 
and Vce(sat) power analysis.

The Rds(on) characteristic is also published in the switching device data sheet.

Vce(sat)

Vce(sat) is a switching device characteristic that can be measured by the Rds(on) 
and Vce(sat) power analysis.

The Vce(sat) characteristic is also published in the switching device data sheet.

Power Loss

Pn = Vdsn * Idn, where n is each sample.

The power loss measurement is made on one source input that represents power. 
This is typically a math multiply waveform of the voltage and current waveforms.

Power Loss/Cyc

Pn = (Vdsn * Idn) * (Time range of zoom window) * (Counter measurement of the 
voltage of the switching signal), where n is each sample.
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The power loss per cycle measurement is made on one source input that 
represents power. This is typically a math multiply waveform of the voltage and 
current waveforms.

This measurement operates when in zoom mode and the counter measurement is 
installed on the voltage of the switching signal.

Energy Loss

=  (Vdsn * Idn) * sample size, where n is each sample.

The energy loss measurement is made on one source input that represents power. 
This is typically a math multiply waveform of the voltage and current waveforms.
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10070D passive probe, 9
1141A differential probe, 9
1147B current probe, 9
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accessing the Power Measurement 
Application, 11

apparent power, 3, 22, 66
at a glance, 3
Average, power modulation analysis, 41
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bandwidth (oscilloscope) requirements, 7
Blackman-Harris window, 24
block diagram, switch-mode power 

supply, 3
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channel deskew, performing, 12
conduction, 35
conduction loss, 3, 33
configuration (test) parameters, 17
connection to device under test, 16
control loop response (Bode), 59
control loop response (Bode) settings, 61
control loop response (Bode) signals, 60
copyright, 2
crest factor, 3, 22, 66
current harmonics, 23
current harmonics analysis settings, 24
current harmonics analysis signals, 23
current harmonics Class D settings, 25
current harmonics plot parameter, 25
current harmonics standard parameter, 25
current harmonics test results, 25
current probe, 9
current probe attenuation factor 

parameter, 17
current switching level, 35

D

deskew (channel), performing, 12
deskew fixture (U1880A), 10, 12
device under test, connection to, 16
dI/dt, 3, 39
dI/dt test results, 39
differential probe, high-voltage, 9
duration for turn on/off analysis, 47
duration of Efficiency analysis, 53
duration of load change, 49
duration of Modulation analysis, 40
duration of output ripple analysis, 44
Duty Cycle, power modulation analysis, 41
dV/dt, 3, 39
dV/dt test results, 39

E

efficiency analysis signals, 51
efficiency, power app automatic 

measurement, 68
energy loss, 70
expected inrush current, 29

F

Fall Time, power modulation analysis, 41
FFT waveform (plot), 26
Frequency, power modulation analysis, 41

G

getting started, 11

H

Hamming window, 24
Hanning window, 24
harmonic, 26
HD3-Series oscilloscopes, 8
high load current parameter, 50
high-voltage differential probe, 9

I

I crest factor, 67

IEC 61000-3-2 standard, 3, 25
input power, 67
inrush current, 27
inrush current analysis, 27
inrush current analysis signals, 27
inrush current test results, 29

L

line frequency parameter, 25
load transient response test results, 50
low load current, 50

M

maximum source voltage, 47
memory (oscilloscope) requirements, 8
modulation, 39
modulation analysis, 3
modulation analysis settings, 41
modulation analysis signals, 39

N

N2780A current probe, 9
N2781A current probe, 9
N2782A current probe, 10
N2783A current probe, 10
N2790A high-voltage differential probe, 9
N2791A high-voltage differential probe, 9
N2792A differential probe, 9
N2793A differential probe, 9
N2870A passive probe, 9
N2891A high-voltage differential probe, 9
N2893A current probe, 9
negative Duty Cycle, power modulation 

analysis, 41
negative pulse width, power modulation 

analysis, 41
noise floor, 35
notices, 2
null offset, 35
number of cycles, 20, 24

O

offset calibration, 31, 35
oscilloscope bandwidth requirements, 7
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oscilloscope memory requirements, 8
oscilloscope probe requirements, 9
oscilloscope requirements, 7
oscilloscope software version 

requirements, 8
output noise, 3
output power, 67
output ripple, 67
output ripple analysis signals, 43
output voltage ripple, 43
output voltage ripple test results, 44
overall efficiency, 51
overall efficiency test results, 53
overall system efficiency, 68
overview, 3

P

parameters, test configuration, 17
passive probe, 9
peak current, 68
percent overshoot, 49
Period, power modulation analysis, 41
phase angle, 22, 67
positive pulse width, power modulation 

analysis, 41
power factor, 3, 22, 65
power loss, 69
power loss per cycle, 69
power measurements, more about, 19
power quality, 3, 19
power quality analysis signals, 19
power quality test results, 21
power supply rejection ratio (PSRR), 55
power supply rejection ratio (PSRR) 

settings, 57
power supply rejection ratio (PSRR) 

signals, 56
pre-compliance testing, 3
prerequisites, 7
probe (oscilloscope) requirements, 9
probe (oscilloscope), current, 9
probe (oscilloscope), high-voltage 

differential, 9
probe (oscilloscope), passive, 9
PSRR (Power Supply Rejection Ratio), 4
PWM (pulse width modulation), 3

R

Ratio, power modulation analysis, 41
Rds (dynamic ON resistance) waveform, 35
Rds(on), 69
Rds(on) and Vce(sat), 29
Rds(on) and Vce(sat) analysis results, 31
reactive power, 22, 66
real (actual) power, 22, 66
requirements, current probe, 9
requirements, deskew fixture, 10

requirements, high-voltage differential 
probe, 9

requirements, oscilloscope, 7
requirements, oscilloscope bandwidth, 7
requirements, oscilloscope memory, 8
requirements, oscilloscope probe, 9
requirements, oscilloscope software 

version, 8
requirements, passive probe, 9
results (test), viewing, 18
ripple measurements, 3
Rise Time, power modulation analysis, 41
RMS - AC, power modulation analysis, 41
running tests, 18

S

safety, 7
selecting tests, 15
slew rate analysis settings, 38
slew rate analysis signals, 37
slew rate of Id in power device, 39
slew rate of Vds in power device, 39
slew rate power analysis, 37
software (oscilloscope) version 

requirements, 8
software version (oscilloscope) 

requirements, 8
Statistics... button, 21
steady state DC output voltage, 47, 50
switching loss, 3, 33
switching loss analysis settings, 34
switching loss analysis signals, 30, 33
switching loss test results, 36
switch-mode power supply block 

diagram, 3

T

test configuration, 17
test results, viewing, 18
test selection, 15
tests, running, 18
THD (total harmonic distortion), 26
total harmonic distortion, 3
transient response, 48
transient response analysis, 48
transient response analysis settings, 50
transient response analysis signals, 48
transient response time, 68
true power, 3
turn off time, 46, 69
turn off time test results, 47
turn on time, 46, 68
turn on time test results, 47
turn on/off analysis, 45
turn on/off analysis settings, 46
turn on/off analysis signals, 45

U

U1880A deskew fixture, 10, 12

V

V crest factor, 67
Vce(sat), 69
Vce(sat) and Rds(on), 29
Vce(sat) and Rds(on) analysis results, 31
viewing test results, 18
viewing waveforms, 18
voltage (high) differential probe, 9
voltage probe attenuation factor 

parameter, 17
voltage switching level, 35

W

warranty, 2
waveforms, viewing, 18
window parameter (FFT analysis), 24
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